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Predgovor

Senzori su uredaji ili komponente koji detektuju dogadaje ili promene u svom okruzenju
i $alju informacije drugim elektronskim uredajima, najcesce sistemima mikrokontrolera.
Senzori se koriste u svakodnevnom zivotu za merenje stavki, kao $to su temperatura, vlaga,
pritisak, vetar i kisa, dodir, nivo svetlosti, nivo te¢nosti, nadmorska visina, sila i jo§ mnogo
toga.

Iako neki senzori imaju digitalne izlaze, ve¢ina senzora koji se koriste u svakodnevnom zi-
votu imaju analogne izlaze, obi¢no u obliku napona koji su proporcionalni izmerenim ko-
licinama. Ovaj izlazni napon se obi¢no dovodi do ulaznog porta mikrokontrolera, radi
obrade. Na primer, izlaz analognog temperaturnog senzora je povezan sa analognim ulaz-
nim portom (analogno-digitalnim pretvara¢em) mikrokontrolera. Mikrokontroler o¢i-
tava temperaturu kao digitalnu vrednost i pretvara je u stvarnu fizi¢cku temperaturu, koja
se zatim prikazuje ili koristi za kontrolu temperature masine ili prostorije.

Ova knjiga govori o kori$¢enju senzora koji se nalaze u kompletu senzora. U kompletu
ima ukupno 40 senzora. Jedni senzori imaju analogne izlaze, dok drugi imaju digitalne iz-
laze, a tre¢i imaju i analogne i digitalne izlaze. Komplet uklju¢uje senzore za merenje tem-
perature, vlaznosti, atmosferskog pritiska, ja¢ine svetlosti i zvuka. Tu su takode 2 i 3 LED
indikatora u boji, nagibni prekidaci, magnetni prekidaci, releji, reed prekidaci, piezo zu-
jalica, taster, dzojstik, detektor prepreka, senzor otkucaja srca, analogno-digitalni pretva-
raé, pretvarac napona, prekidac za vibracije itd.

40 senzora u kompletu All-in-1

Knjiga je namenjena za ucenje kako se koriste senzori sa popularnim sistemima za razvoj
mikrokontrolera: Arduino Uno, ESP32 DevKitC i Raspberry Pi. Dati su primeri projekata
u kojima je prikazano kako se koriste senzori sa ovim mikrokontrolerima. Programi se

Poglavlje 1« Arduino Uno hardverski interfejs i razvoj projekta 11



mogu modifikovati za ostale mikrokontrolere, kao $to su PIC, STM32, Banana Pi, Cubie-
Board, Beaglebone itd.

Svi projekti navedeni u knjizi su izradeni kori$¢enjem prototipske ploce standardne veli-
¢ine i potpuno su testirani i funkcionalni. Projekti su opisani sa slede¢im podnaslovima:

« Opis projekta

« Cilj projekta

« Blok dijagram

« Elektri¢na $ema
« Listing programa

Rad svakog senzora i svaki listing programa detaljno su opisani tako da ¢itaoci nece imati
poteskoca u konstruisanju ili prosirivanju datog projekta. U nekim projektima se koristi
vide senzora iz kompleta. Citaocima se preporucuje da prate projekte navedenim redosle-
dom, jer neke od softverskih alatki koje se koriste u nekim projektima zavise od instala-
cije ovih alatki u prethodnom projektu.

Kompletni listing programa projekata sa mnogo komentara dostupan je na veb sajtu Elek-
tor knjige, a ¢itaoci bi trebalo da kopiraju i koriste ove programe, bez potrebe za izme-
nama.

Arduino Uno i ESP32 DevKitC programi zasnivaju se na koris¢enju Arduino IDE-asa C
jezikom. U Raspberry Pi projektima koristi se programski jezik Python. Iako se u projek-
tima zasnovanim na Arduinu navodi Arduino Uno kao razvojna ploca, ovi bi projekti tre-
balo takode da funkcionisu sa drugim Arduino razvojnim plo¢ama, kao $to su Arduino
Mega, Arduino Nano itd.

Nadam se da ¢e ¢itaocima knjiga biti od koristi i da ¢e uzivati u eksperimentisanju sa raz-
li¢itim senzorima.

Dogan Ibrahim
jun, 2019.
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Poglavlje 1 - Arduino Uno hardverski interfejs i razvoj projekta

1.1Pregled

U ovoj knjizi ¢emo koristiti Arduino Uno plo¢u u senzorskim projektima koji se zasnivaju
na Arduinu. Ovo poglavlje prikazuje lokaciju razli¢itih komponenti na plo¢i Arduino Uno
i takode opisuje hardverski interfejs za spoljni svet. U ovom poglavlju dat je jednostavan
projekat koji ¢e ¢itaoca upoznati sa razvojem programa pomocu ploce Arduino Uno. U
prvom programu dvobojni LED treperi naizmeni¢no svake sekunde.

1.2 Arduino Uno ploca
Na slici 1.1 je detaljno prikazana plo¢a Arduino Uno sa oznacenim glavnim kompone-
ntama.

Definicije pinova su sledece (pogledajte 1.2).

A0 - A5 Analogni ulazni portovi

0-13 Portovi za digitalni ulaz/izlaz

~3,~5,~6,~9,~10,~11: | PWM izlazni portovi

UART RX/TX pinovi. LED-ovi sa oznakom TX, RX Ce treperiti

0,1: kada se podaci Salju ili primaju, tim redosledom.
GND: Pin za uzemljenje napajanja

5V: Regulisani izlaz od +5 V

3,3V Regulisani izlaz od 3,3 V

Ulaz napona (umesto upotrebe Power In-a ili USB-a). Napon
mora biti u opsegu od 7 V do 12 V. Interno je regulisan na +5
Vin: V. Ovaj pin se takode moze koristiti kao izlaz napona (ako se
napaja pomocu Power In-a ili USB prikljucka). Napon je kopija
napona koji se dobija pomocu Power In-a ili USB prikljucka.
Koriste ga spoljni moduli da bi znali da li treba da rade kao

[ORef: +3,3 Vili kao +5 V uredaii.

Power In: Barrel Jack pin za napajanje (od 6 V do 12 V).

USB port: Priklju¢ak za napajanje i podatke (povezuje se sa racunarom).
User LED: Ugradeni LED koji je povezan sa izlaznim portom 13 (moze se

koristiti za svrhe testiranja).

Primeticete da kada Arduino Uno napaja USB prikljuc¢ak (npr. sa racunara), maksimalni
kapacitet struje je oko 400 mA za +5 V pin i 150 mA za + 3,3 V pin. Kada se napaja iz
spoljnog izvora, maksimalna struja za 5 V pin je oko 900 mA i 150 mA za + 3,3 V pin.
Svaka struja izvucena iz + 3,3 V prolazi kroz pin + 5 V. Stoga, ovo morate uzeti u obzir pri-
likom napajanja spoljnih uredaja.

Apsolutna maksimalna struja za bilo koji I/O pin je odredena kao 40 mA (ipak se prepo-
rucuje da ne premasi 20 mA). Apsolutna ukupna struja iz svih I/O pinova je 200 mA.

Poglavlje 1« Arduino Uno hardverski interfejs i razvoj projekta 13
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This s the ICSP hoader lor thal mecrocontiolier

» Sl COMMUNICAons

GPIOTE ADC4 SDA
GPO19 ADCS SCL

AREF
Gined
GPIO13 SCK LED
1080t GPIO12
+3 W GRIO
ey GO
Gnd GHIO9
Gnd GPIO8S
Vin GHRIO?
GHIOG
ADCO GPIO14 GPIOS
ADCY GPIO1S GRIO4
ADC2 GPIO16 GPIOS 15 INTY
ADC3 GPIOy GRIO2 INTO
SDA ADC4 GPIOE GHRIO I
SCL ADCS GPIO1D [S1 [#4] RX
Comm ADC  GPIO GPIO  ADC  Comm. PWM  Intorrupts

Gnd MOSI  «5V

Slika 1.2 Arduino Uno raspored pinova

1.3 Razvoj programa Arduino Uno

Lepa karakteristika svih Arduino ploca je ta $to se sve one mogu programirati pomocu
Arduino IDE-a. Najnovija verzija Arduino IDE-a moze se preuzeti sa veb sajta koji je dat
ispod. U vreme pisanja ove knjige najnovija verzija je bila 1.8.8:

https://www.arduino.cc/en/Main/Software
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Ovo su koraci za pisanje i u¢itavanje programa na Arduino Uno:
Povezite Arduino Uno sa USB priklju¢kom na racunaru.
Pokrenite Arduino IDE na racunaru.

« Kliknite na Tools -> Board i izaberite tip ploce Arduino/Gerduino Uno.

« Kliknite na Tools -> Port i izaberite serijski port sa kojim je povezan va§ Arduino
Uno.

« Napisite i sacuvajte va$ program.

« Kliknite na Sketch -> Verify/Compile da biste kompajlirali program. Proverite da
li ima gresaka prilikom kompajliranja.

« Kliknite na Sketch -> Upload da biste poslali izvrsivi kod u programsku memoriju
Arduino Uno-a.

U narednim odeljcima data su dva primera projekta da bi se ¢italac upoznao sa ciklusom
razvoja projekata, koriste¢i Arduino Uno. Pretpostavlja se da ¢italac ima neko osnovno
znanje o elektronici, a takode i neko prakti¢no poznavanje pisanja jezika visokog nivoa.

1.4 Projekat - Treperenje dvobojnog LED-a

Opis - Ovo je mozda najlaksi projekat koji mozete dizajnirati, koriste¢i Arduino Uno. U
ovom projektu dvobojni LED sa zajednickom katodom povezan je sa Arduino Uno-m.
LED boje trepere naizmeni¢no brzinom od jedne sekunde.

Cilj - Cilj ovog projekta je da se prikaze kako se program moze napisati, kompajlirati i
preneti u Arduino Uno. U projektu je takode prikazano kako se koriste neki od I/O i funk-
cija za podesavanje vremena na Arduinu.

Senzor koji se koristi - U ovom projektu se koristi senzor KY-011. Ovaj senzor sastoji se
od LED crvene i zelene boje smestene u paketu sa zajednickim katodnim terminalom. Sen-
zor i njegovi pinovi prikazani su na slici 1.3. Senzor ima 3 pina - crveni LED pin, zeleni LED
pin i GND pin. Zeleni LED pin oznacen je slovom S na ploci, radi identifikacije. LED
se ukljucuje kada se logicka 1 primeni na njegove pinove. Osnovne specifikacije ovog sen-
zora su sledece:

Radni napon: 0d2,0do2,5V
Radna struja: 10 mA (zavisi od potrebne svetline)
Talasna duzina: zeleni (571 nm), crveni (644 nm)

Jacina svetlosti (MCD):  zeleni (20-40), crveni (40-80)
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A
Green
A Common Cathode
Red

LED

Slika 1.3 Senzor KY-011

Blok dijagram - Blok dijagram projekta prikazan je na slici 1.4.

Arduino Uno

RED LED

‘ GREEN LED

Slika 1.4 Blok dijagram projekta

Elektri¢na Sema - Elektricna $ema projekta prikazana je na slici 1.5. Zeleni i crveni LED
pinovi su povezani sa pinovima porta 2 i 3 Arduino Uno-a putem otpornika za ogranica-
vanje struje. GND pin je povezan sa Arduino Uno GND pinom. Vrednost otpornika za
ogranicavanje struje izracunava se na sledeci nacin:

Visoki napon izlaznog pina je 5 V. Napon propusne polarizacije na LED-u je oko 2,0 V (za
crveni LED je 1,8 V, a za zeleni LED 2,8 V). Pod pretpostavkom da ¢e propusna struja za
LED biti postavljena na 10 mA (razumna svetlina), tada je vrednost otpornika za ograni-
¢avanje struje:

R=(5V-2V)/10 mA = 300 oma, koristite otpornik od 330 oma

(mozete koristiti manju vrednost, npr. 270 oma za zeleni LED)

Na slici 1.5, LED radi u rezimu snabdevanja strujom u kojem visoki izlaz iz I/O pina po-
kre¢e LED. LED moze da radi i u trenutnom rezimu odvodenja struje u kojem je drugi
kraj LED-a povezan sa napajanjem od +5 V, a ne sa uzemljenjem. U rezimu odvodenja
struje, LED se ukljucuje kada je I/O pin logicki nizak.
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Arduino UNO
KY-011

2

850,
3239 1R

1

GND =

1

Slika 1.5 Elektri¢na Sema projekta

Konstrukcija - Projekat je izraden na ploci, kao $to je prikazano na slici 1.6. Kratkospoj-
nici se koriste za povezivanje senzora KY-011 sa digitalnim pinovima porta 213 i GND-
om Arduino Uno-a.

Slika 1.6 Projekat konstruisan na prototipskoj ploci
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Listing programa - Program se zove TWOCOLOUR, a listing je prikazan na slici 1.7. Na
pocetku programa pinovi porta 2 i 3 se dodeljuju zelenom LED pinu i crvenom LED pinu,
tim redom. Unutar rutine podesavanja pinovi porta 2 i 3 na kojima su priklju¢eni LED pi-
novi konfigurisani su kao izlazi. Unutar glavne programske petlje dve boje se uklju¢uju i
isklju¢uju naizmenic¢no, sa kasnjenjem od jedne sekunde izmedu svakog izlaza. Kliknite na
Verify/Compile da biste bili sigurni da nema gresaka, a zatim kliknite na Upload da biste
otpremili programski kod u Arduino Uno. Trebalo bi da vidite kako dve boje trepere br-
zinom od jedne sekunde.

Autor izric¢ito preporucuje da komentarisete redove u vasem programu i da opisete ope-
raciju koja se izvodi, kao $to je prikazano na slici 1.7. Takode trebalo bi da dodate naslov
i da ukratko opisete $ta program radi. To olaksava kasnije razumevanje i odrzavanje pro-
grama. To takode olaksava bilo kome drugom da razume logiku programa kada ga procita.

/******************************************************************
* FLASHING GREEN AND RED LEDs

* B e e e e

*

* In this program the KY-011 sensor is used which has a green and

* a red LED with a common cathode terminal. The green LED and the

* red LED are connected to I/O pins 2 and 3 of the Arduino Uno

* respectively. The program flashes the LEDs alternately at a rate
* of one second.

* Author: Dogan Ibrahim

* Date : April 2019

* File : TWOCOLOUR
******************************************************************/
int GreenLED = 2; // Green LED pin

int RedLED = 3; // Red LED pin

#define ON HIGH

#define OFF LOW

void setup()

{
pinMode (GreenLED, OUTPUT); // Set as output
pinMode (RedLED, OUTPUT); // Set as output

void loop()

{
digitalWrite(GreenLED, ON); // Turn ON green
digitalWrite(RedLED, OFF); // Turn OFF red
delay (1000); // Wait 1 sec
digitalWrite(GreenLED, OFF); // Turn OFF green
digitalWrite(RedLED, ON); // Turn ON red
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delay (1000); // Wait 1 sec
}

Slika 1.7 Listing programa projekta

Sta smo naudili - U ovom projektu smo naudili kako da koristimo slede¢e Arduino funk-
cije:

int: deklarise celobrojnu promenljivu

#define: dodeljuje vrednost ili tekst nizu

pinMode (port pin, mode): koristi se za konfigurisanje I/O pin
porta kao ulaza ili izlaza

digital Write(pin port, value): koristi se za ispis digitalne vrednosti (lo-
gicko LOW ili HIGH) na pin portu

delay(n): kreira kasnjenje od n milisekundi

1.5 Rezime

U ovom poglavlju smo videli razne komponente i definicije pinova Arduino Uno mikro-
kontrolera. Osim toga, dat je jednostavan projekat u kome je prikazano kako se dizajniraju
jednostavni projekti i kako se kompajlira i $alje programski kod u programsku memoriju
Arduino Uno mikrokontrolera.

U slede¢em poglavlju ¢emo pogledati kako se koristi Raspberry Pi mikrokontrolera u pro-
jektima.
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Poglavlje 2 - Raspberry Pi hardverski interfejs i razvoj projekta

2.1 Pregled

U ovoj knjizi ¢emo koristiti Raspberry Pi 3 Model B u nasim Raspberry Pi projektima. U
ovom poglavlju prikazana je lokacija razli¢itih komponenti na plo¢i Raspberry Pi i opisan
je hardverski interfejs za spoljni svet. Pode$avanje Wi-Fi mreze i daljinski pristup Raspberry
Pi rac¢unaru i upoznavanje sa Python programskim okruzenjem su takode ukratko opi-
sani. Prikazan je jednostavan projekat da bi se ¢italac upoznao sa koracima za dizajnira-
nje projekta. U ovoj knjizi kada piSemo Raspberry Pi 3 zapravo mislimo na Raspberry Pi
3 Model B.

2.2 Ploca Raspberry Pi 3
Na slici 2.1 prikazana je plo¢a Raspberry Pi 3 sa oznac¢enim glavnim komponentama. Neki
detalji o svakoj komponenti dati su u ovom odeljku.

BCM43438 Nk

Ethernet
And Wi-Fi

SD card R <8 CsSl Audio/Video
slot L =T HDMI

USB power

Slika 2.1 Ploca Raspberry Pi 3

USB prikljucci: Raspberry Pi 3 ima 4 USB prikljucka za povezivanje misa, ta-
stature, veb kamere itd.

Ethernet i Wi-Fi: Tako Raspberry Pi 3 ima ugraden Wi-Fi, on se takode moze di-
rektno povezati sa ruterom preko Ethernet kabla koji je pove-
zan sa ovom uti¢nicom.

Audio/video priklju¢ak: Na ovu 3,5 mm uti¢nicu mogu se prikljuciti slusalice ili zvuc-
nik. Ova uti¢nica takode sadrzi kompozitni video interfejs.

CSI: Ovo je serijski interfejs kamere na koji se moze prikljuciti kom-
patibilna Raspberry Pi kamera.

HDMI: Na ovaj prikljuc¢ak se moze povezati odgovarajuci monitor. Pri-
kljuc¢ak prenosi i audio i video signale.

USB napajanje: Na ovu USB uti¢nicu treba prikljuciti napajanje od + 5V 2 A
da bi se napajao Raspberry Pi.
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Otvor za SD Kkarticu: Mikro SD kartica koja prenosi operativni sistem mora biti pri-
klju¢ena na ovaj otvor.

DSI: Sa ovim interfejs ekranom moze se povezati odgovarajuci Di-
play Interface konektor.

SOC: Ovo je Broadcom BCM2837 System On Chip (SOC) koji sa-
drzi 64-bitni cetvorojezgarni ARM Cortex-A53 procesor od 1,2
GHz.

GPIO: Ulazno-izlazni port za opstu namenu je $irok 40 pinova.

BCM43438: Ovaj ¢ip obezbeduje Wi-Fi i Bluetooth za Raspberry Pi 3.

2.3 GPIO definicije pinova na Raspberry Pi 3

Raspberry Pi 3 je povezan sa spoljnim digitalnim elektronskom kolima i uredajima, pomocu
GPIO (General Purpose Input Output) konektora porta. Ovo je 2,54 mm 40-pinsko za-
glavlje za prosirenje koje je rasporedeno na traci 2 x 20, kao $to je prikazano na slici 2.2.

8 GPIO14
10 GPIO15
GPIO17 11 12 GPIO18
GPIO27 13 14
GPIO22 15 16 GPIO23
17 18 GPIO24
GPIO10 19 20
GPIO9 21 22 GPIO25
GPIO11 23 24 GPIO8
25 26 GPIO7
DNC 27 28 DNC

GPIO19 35 36 GPIO16
LT GPIO26 37 38 GPIO20
v/ v/ [ 39 40 GPIO21

Slika 2.2 GPIO pinovi na Raspberry Pi 3

Kada je GPIO konektor na drugoj strani ploce, pinovi na dnu, pocevsi od leve strane ko-
nektora, oznaceni su brojevima 1, 3, 5, 7 i tako dalje, dok su oni na vrhu oznaceni kao 2,
4, 6, 8 i tako dalje.

GPIO obezbeduje 26 dvosmernih I/O pinova op$te namene. Neki pinovi imaju vise funk-
cija. Na primer, pinovi 3 i 5 su GPIO2 i GPIO3 pinovi za ulaz i izlaz. Ovi pinovi se takode
mogu koristiti kao I2C magistrala I2C SDA i I2C SCL pinova, tim redom. Sli¢no tome, pi-
novi 9,10,11,19 se mogu koristiti kao ulaz-izlaz op$te namene ili kao SPI pinovi magistrale.
Pinovi 8 i 10 su rezervisani za UART serijsku komunikaciju.

Obezbedena su dva izlaza za napajanje: +3,3 Vi +5,0 V. GPIO pinovi rade na logickim ni-
voima od +3,3 V (ne kao kod mnogih ra¢unarskih kola koja rade na +5 V). Pin moze biti
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ulaz ili izlaz. Kada je konfigurisan kao izlaz, napon pina je 0 V (logicka 0) ili +3,3 V (logi-
¢ka 1).

Raspberry Pi 3 obi¢no radi pomocu spoljnog napajanja (npr. pomoc¢u mreznog adaptera)
sa +5 V izlazom i minimalnim naponom od 2 A. Izlazni napon od 3,3 V moze da napaja
do 16 mA struje. Ukupna struja izvucena iz svih izlaznih pinova ne sme preci granicu od
51 mA. Treba da budete oprezni kada prikljucujete spoljne uredaje na GPIO pinove, jer pre-
velika potrosnja struje ili kratki spoj na pinu mogu lako ostetiti va$ Pi. Koli¢ina struje koja
moze da napaja 5 V pin zavisi od mnogih faktora, kao $to su struja koja je potrebna za sam
Pi, struja koju koriste USB periferne jedinice, struja kamere, struja HDMI prikljucka i tako
dalje.

Kada je konfigurisan kao ulaz, napon iznad + 1,7 V se smatra kao logicka 1, a napon ispod
+ 1,7 V se smatra kao logicka 0. Treba voditi ra¢una da napon ve¢i od + 3,3 V ne bude ispo-
rucen na I/O pinove, jer veliki naponi mogu lako da ostete vas Pi. Raspberry Pi 3, kao i ostali
Pi ra¢unari u porodici, nemaju zastitno kolo od prenapona.

2.4 Postavljanje Wi-Fi-ja i udaljenog pristupa
Vrlo je verovatno da zelite da pristupite Raspberry Pi-u 3 daljinskim putem sa radne po-
vréine ili sa prenosnog racunara. Najlaksa opcija ovde je da na vasem Pi ra¢unaru omogucite
Wi-Fiida mu zatim pristupite sa racunara, koriste¢i SSH protokol klijenta. Ovaj protokol
zahteva server i klijent. Server je va$ Pi racunar, a klijent je va$ stoni ili prenosni racunar.
U ovom odeljku ¢emo videti kako da na Pi racunaru omoguc¢imo Wi-Fi i kako da mu pri-
stupimo daljinskim putem.
Podesavanje Wi-Fi-ja

« Da biste omogucili Wi-Fi na vasem Pi-u, pratite sledece korake:

o Kliknite na ikonu Wi-Fi, tj. na par crvenih krsti¢a u gornjem desnom uglu ekrana.

o Izaberite va§ Wi-Fi ruter sa prikazane liste (pogledajte sliku 2.3).

Tum Off Wi-Fi

BTWifi-with-FON

BTWifi-X =
Chromecast7872.b
HP-Print-19-LaserJet 200 color
The Hotal &

Slika 2.3 Izaberite vas Wi-Fi sa liste

» Unesite lozinku za va§ Wi-Fi ruter.
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« Ikona WiFi trebalo bi da postane tipi¢na Wi-Fi slika. Ako sada kliknete na ikonu,
trebalo bi da vidite zeleni znak potvrde pored odabranog rutera, kao $to je prika-
zano na slici 2.4.

v/ BTHomeSpot XNH

BIWifi-with-FON
BTWIfi-X
Chromecast/872 b

HP-Print-19-LaserJet 200 color
The Hotal

Slika 2.4 UspeSno povezivanje sa Wi-Fi mrezom

o Da biste videli IP adresu vase Wi-Fi veze, postavite mis iznad ikone Wi-Fi, kao $to
je prikazano na slici 2.5. U ovom primeru IP adresa je 192.168.1.84.

BTWifi-with-FON :
BTWifi-X - E

Chromecast7872.b
HP-Print-19-LaserJet 200 color 5

The Hotal

Slika 2.5 IP adresa nase veze

Daljinski pristup
Program koji ¢emo koristiti za pristup naSem Raspberry Pi-u 3 zove se Putty sa SSH pro-
tokolom. Ovo su koraci za preuzimanje i upotrebu aplikacije Putty:
o Preuzmite Putty sa sledeceg linka (ili u pretrazivacu Google potrazite ,,Download
Putty).
http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html
« Zbog bezbednosnih razloga SSH protokol je na novom operativhom sistemu po-
drazumevano onemogucen. Da biste ga omogucili, kliknite na meni Applications

u gornjem levom delu ekrana, kliknite na Accessories, a zatim kliknite na Termi-
nal (pogledajte sliku 2.6).
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| - Archiver

| @ Help > EH Calculator

Iy __'L_L| File Manager

Preferences |

3 |l Image Viewer
‘:?( Run

' B POF Viewer

. Shutdown D SD Card Copier
i fask Manager
u Terminal

f Text Editor

Slika 2.6 Pristupite meniju Terminal

« Sada bi trebalo da budete u komandnom odzivniku Raspberry Pi 3. Tip:

sudo raspi-config
« Da biste usli u meni za konfiguraciju i izabrali Interface Options. Idite na P2 SSH

i omogucite SSH, kao §to je prikazano na slici 2.7.

Edit Tabs Help

Slika 2.7 Omogucite SHH server

o Kliknite na <Finish> da biste iza$li iz konfiguracionog menija. Sada bi trebalo da
se vratite u komandni rezim, koji je identifikovao odzivnik:

pi@raspberrypi:~ $



« Putty je samostalan program i nema potrebe da ga instalirate. Jednostavno kliknite
dva puta da biste ga pokrenuli. Trebalo bi da vidite ekran za pokretanje softvera

Putty kao na slici 2.8.

£R PuTTY Configuration T =X}
- Session | Basic options for your PuTTY session
L Loggng Speciy the destnation you wart 1o connect to
T L Keybourd Host Nome for IP address) __ Pod
Bed I 2
Features Connection type:
= Window “IRaw ) Teinet ) Rlogn @ SSH Senal 1
Behaviour Load, save or delete a stored session
Translation Saved Sessions
Selection
el s
= Connection ESP01 (o) :
= e [Csom )
r |
Teh_q | Delete
[ SSH :
Seidl Close window on exdt:
Aways ! Never /@ Only on clean et
T (o0 J[ Cocs |

Slika 2.8 Putty pocetni ekran

o Proverite da li je tip veze SSH i unesite IP adresu vaseg Raspberry Pi 3. Kliknite na
Open, kao $to je prikazano na slici 2.9.

3 PuTTY Configuration ]
2 Loggng Speciy the destination you wart to connect to
Keyboard Host Name {or IP address) Port
Bel 192 168.1.84 2
Features Connection typs:
| = Window Raw Teinet () Rlogin @ S5H Senal
Dot Load, save or delete » stored session
Translation Saved Sessions
| Secio
Colours Defak
|| e =y —
Data Conin |
[ Telnat Delete |
| Riogn
#- SSH
L Sedd Close window on ed:
Aways Never @ Only on clean st
|
[ Ao ] [ O ][ Conce |

Slika 2.9 Unesite IP adresu

o Poruka koja je prikazana na slici 2.10 ¢e biti prikazana na ekranu rac¢unara prvi

put kada pristupite Raspberry Pi-u 3. Kliknite na Yes da biste prihvatili ovo bez-
bedonosno upozorenje.
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e =

The server’s host key is not cached in the registry. You
! % have no guarantee that the server is the computer you

think it is.

The server’s rsaZ key fingerprint is:

ssh-rsa 2048 de:71:8e:57:84:12:46:84:43:98:80:aT:e5:ef:d8:14

If you trust this host, hit Yes to add the key to

PuTTY's cache and carry on connecting.

If you want to carry on connecting just once, without

adding the key to the cache, hit No. |

If you do not trust this host, hit Cancel to abandon the |

connection. ‘
|
|
|

Yes No | Cancel !

Slika 2.10 Kliknite na Yes za prihvatanje

« Tada Cete biti upitani za korisnicko ime i lozinku. Zadate vrednosti su:
Korisni¢ko ime: pi
Lozinka: raspberry

« Nakon uspesne prijave, trebalo bi da vidite Raspberry Pi komandni odzivnik kao
na slici 2.

@ pi@raspberrypi: ~ E=SE

Slika 2.11 Uspesno prijavljivanje

« Da biste promenili lozinku, unesite slede¢u komandu:
passwd
o Da biste ponovo pokrenuli Raspberry Pi ZW, unesite slede¢u komandu:
sudo reboot
« Da biste iskljucili Raspberry Pi ZW, unesite slede¢u komandu. Nikada ga ne isklju-

Cujte izvlacenjem kabla za napajanje, jer to moze dovesti do o$tecenja ili gubitka
datoteka:

sudo shutdown -h now



2.5 Iskljucivanje ili ponovno pokretanje u GUI rezimu
Uvek morate pravilno iskljuciti svoj Pi ra¢unar. Da biste ga iskljucili u GUI rezimu, sledite
korake koji su navedeni ispod:

« Kliknite na meni Applications (gornji levi ugao).

o Kliknite na Shutdown (pogledajte sliku 2.12).

o Kliknite na Shutdown (ili ponovo pokrenite Pi ra¢unar po potrebi).

Siytdown

Slika 2.12 Iskljucite ili ponovno pokrenite Pi racunar u GUI rezimu

2.6 Daljinski pristup radnoj povrSini

Ako koristite Raspberry Pi 3 sa lokalnom tastaturom, miSem i monitorom, mozete da pre-
skocite ovaj odeljak. Ako s druge strane zelite da radnoj povrsini pristupite daljinski putem
mrezZe, ustanovicete da se SSH usluge ne mogu koristiti. Najlaksi i najjednostavniji nacin
na koji mozete daljinski pristupiti radnoj povrsini sa ra¢unara je instaliranjem VNC (Vir-
tual Network Connection) klijenta i servera. VNC server se pokrece na Pi-u, a VNC kli-
jent radi na racunaru. Koraci za instaliranje i upotrebu VNC-a dati su u nastavku:

« Povezite se na svoj Pi racunar pomoc¢u SSH-a, kao $to je ranije objasnjeno. Zatim,
unesite slede¢u komandu da biste na svoj Pi racunar instalirali program koji se
zove TightVNC server. Videc¢ete mnogo redova poruka. Proverite da li ima poruka
o gresci:

sudo apt-get update

sudo apt-get install tightvncserver
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o Pokrenite VNC server na Pi ra¢unaru unosom sledeée komande:

vncserver: 1

 Od vas e biti zatrazeno da unesete i potvrdite lozinku. Ovo ¢e biti lozinka koju cete
koristiti za daljinski pristup radnoj povrsini (pogledajte sliku 2.13).

Slika 2.13 Unesite lozinku za VNC server

« VNC server sada radi na vaem Pi racunaru. Jedina komanda koju je potrebno da
unesete na Pi racunar da biste pokrenuli VNC server je:

vncserver :1

« Sada moramo da podesimo VNC klijent na nasem prenosnom rac¢unaru (ili stonom
rac¢unaru). Na raspolaganju je mnogo VNC klijenata, ali preporuceni klijent koji
je kompatibilan sa Tight-VNC-om je VNC Viewer koji mozete preuzeti sa linka koji
je dat u nastavku. Imajte na umu da ovaj program nije besplatan, ali je dostupna
30-dnevna besplatna probna verzija. Treba da se registrujete da biste dobili licencu
za probu, a zatim tu licencu primenite na softver koji ¢ete besplatno koristiti 30
dana:

http://www.realvnc.com

o Preuzmite program VNC Viewer u odgovarajuci direktorijum na ra¢unaru.

o Dva puta kliknite da biste ga instalirali i unesite potrebnu licencu. Pokrenite pro-
gram VNC Viewer dvostrukim klikom na njegovu ikonu na radnoj povrsini. Une-
site IP adresu vaseg Raspberry Pi-a 3, a zatim 1, kao $to je prikazano na slici 2.14
i kliknite na Connect.
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VNC® Viewer =
VNC Server: [192.168.1 84:1 -
Encryption: | Let VNC Server choose v]
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Slika 2.14 Unesite IP adresu

Unesite prethodno izabranu lozinku. Sada bi trebalo da vidite Raspberry Pi 3 radnu povr-
$inu prikazanu na vasem prenosnom (ili stonom) racunaru kao na slici 2.15 i da pristupite
svim aplikacijama radne povrsine daljinskim putem.

2 2 8 sty Siphamy 1) - VHC Viewss TEEERTRINIIIII — e RER AR e

& @ -u_',‘@_ e 3 = ._.'-n_ 1554
o~

r

Slika 2.15 Raspberry Pi 3 radna povrsina prikazana na prenosnom racunaru

2.7 Kreiranje i pokretanje programa Python

Programira¢emo na$ Raspberry Pi 3, koriste¢i programski jezik Python. Korisno bi bilo da
pogledamo kreiranje i pokretanje jednostavnog programa Python na Pi racunaru. U ovom
odeljku ¢emo prikazati poruku Hello From Raspberry Pi 3 na ekranu rac¢unara.

Kao $to je opisano u nastavku, postoje 3 metode pomocu kojih mozemo kreirati i pokre-
tati Python programe na Raspberry Pi 3:

Metod 1 - Interaktivno iz komandnog odzivnika
U ovoj metodi ¢emo se prijaviti na Raspberry Pi 3 pomoc¢u SSH-a, a zatim ¢emo kreirati i

pokrenuti na$ program interaktivno. Ova metoda je odlicna za male programe. Koraci su
dati u nastavku:

Poglavlje 2 « Raspberry Pi hardverski interfejs i razvoj projekta 29



« Prijavite se na Raspberry Pi 3 pomoc¢u SSH-a.

« U komandnoj liniji unesite python. Trebalo bi da vidite Python komandni rezim
koji identifikuju tri znakova >>>.

o Ukucajte program:
print (“Hello From Raspberry Pi 3”)

« Trazeni tekst e se interaktivno prikazivati na ekranu, kao $to je prikazano na slici
2.16.

pi@raspberrypi:~ § python

Python 2.7.13 (default, Jan 19 2017, 14:48:08)

[GCC 6.3.0 20170124] on linux2

Type "help"”, "copyright", "credits" or "license” for more information.
>>> print("Hello From Raspberry Pi 3")

Hello From Raspberry Pi 3

>>> i

Slika 2.16 Interaktivno pokretanje programa

Metod 2 - Kreirajte Python datoteku u komandnom reZzimu

U ovoj metodi ¢emo se prijaviti na na$ Raspberry Pi 3 pomoc¢u SSH-a kao i ranije, a zatim
kreirati Python datoteku. Ova datoteka je jednostavna tekstualna datoteka sa nastavkom .py.
Mozemo koristiti uredivac teksta, kao $to je nano, da bismo kreirali nasu datoteku. U ovom
primeru kreirana je datoteka pod nazivom hello.py, pomoc¢u nano uredivaca teksta. Na slici
2.17 prikazan je sadrzaj datoteke hello.py. Na ovoj slici je takode prikazano kako se pokrece
datoteka u Pythonu. Primeticete da se program pokre¢e unosom komande:

>>> python hello.py

Slika 2.17 Kreiranje i pokretanje Python datoteke

Metod 3 - Kreirajte Python datoteke u GUI rezimu
Na ovaj nacin ¢emo se prijaviti u nas Raspberry Pi 3 pomoc¢u VNC-a, a zatim kreirati i
pokrenuti na$ program u GUI rezimu. Koraci su dati u nastavku:
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o Kliknite na meni Application.

o Kliknite na Programming i izaberite Python 2 ili Python 3 (pogledajte sliku 2.18).
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Slika 2.18 Izaberite Python 2 programiranje

« Trebalo bi da vidite rezim komande Python koji je identifikovan znakovima >>>.
« Kliknite na File, a zatim na New File i napiSite svoj program.
« Sacuvajte datoteku, tako $to Cete joj dati naziv (npr. hello2).

o Pokrenite program klikom na Run, a zatim kliknite na Run Model, kao $to je
prikazano na slici 2.19.

hello2.py - lhome/pi/h

File Edit Format Run| Oplions Window Help

print ("Hello ansnen i Zero W")
Check Module  Alt+X X
RunModule  F5

Slika 2.19 Pokrenite program

« Bice prikazan novi ekran sa izlazom programa kao na slici 2.20.

Python 2.7.13 Shell
Eile Edit Shell Debug Options Window Help

| Python 2.7.13 (default, Jan 19 2017, 14:48:08)
- [6CC 6.3.0 20170124] on linux2

| Type "copyright", "credits" or "license()" for more information.
22>

RESTART: /home/pi/hello2.py
Hello From Raspberry Pi Zero W

o>

Slika 2.20 Izlaz programa
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Koju metodu izabrati?

Izbor metode zavisi od veli¢ine i slozenosti programa. Mali programi se mogu pokrenuti
interaktivno, bez kreiranja programske datoteke. Ve¢i programi se mogu kreirati kao Python
datoteke, a zatim se mogu izvrsiti u komandnom rezimu ili u GUI rezimu. U ovoj knjizi ¢e
biti kreirane programske datoteke za sve Python programe.

2.8 GPIO biblioteka

GPIO biblioteka se zove RPi.GPIO i ve¢ bi trebalo da je instalirana na vasem Raspberry Pi-
u 3. Ova biblioteka mora biti dodata na pocetku vasih Python programa ukoliko Zelite da
koristite GPIO funkcije. Ovo je iskaz za dodavanje ove biblioteke:

import RPi.GPIO as GPIO

Ako se prikaze greska prilikom pokusaja uvoza GPIO biblioteka, onda biblioteka mozda nije
instalirana. Unesite slede¢e komande dok ste u komandnom rezimu (koji je identifikovan
odzivnikom pi@raspberrypi:~ $) da biste instalirali GPIO biblioteku (znakovi koje bi tre-
balo da unesete su podebljani):

pi@raspberrypi: ~ $ sudo apt-get update
pi@raspberrypi: ~ $ sudo apt-get install python-dev
pi@raspberrypi: ~ $ sudo apt-get install python-rpi.gpio

GPIO obezbeduje brojne korisne funkcije. Dostupne funkcije su date u slede¢im odeljcima.

2.8.1 Numerisanje pinova

Postoje dva nacina na koja mozemo ukazati na GPIO pinove. Prvi nacin je kori§¢enje
BOARD numerisanja u kome se koriste pinovi na GPIO konektoru Raspberry Pi-a 3. Da
biste koristili metodu BOARD, unesite slede¢i skaz:

GPIO.setmode (GPIO.BOARD)

Drugi sistem numerisanja, poznat i kao BCM metoda, je pozeljna metoda i koristi brojeve
kanala koji su dodeljeni pinovima. Ova metoda zahteva da znate koji se broj kanala odnosi
na koji pin na plo¢i. U ovoj knjizi ¢emo koristiti ovu drugu metodu. Da biste koristili BCM
metodu, unesite slede¢i iskaz:

GPIO.setmode (GPIO.BCM)

GPIO je 40-pinsko zaglavlje, koje je postavljeno na jednoj strani ploc¢e. U Dodatku A
prikazana je konfiguracija GPIO pinova na Raspberry Pi-u 3.

2.8.2 Konfiguracija kanala (1/0 pinovi porta)

Konfiguracija ulaza

Morate da konfiguriete kanale (ili pinove porta) koje koristite, bez obzira da li su oni
ulazni ili izlazni kanali. Slede¢i iskaz se koristi za konfigurisanje kanala kao ulaza.
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Ovde se kanal za razvoj projekata odnosi na broj kanala na osnovu prethodnog iskaza set-
mode:

GPIO.setup (channel, GPIO.IN)

Kada na ulazni pin nije ni$ta povezano, podaci na ovom ulazu nisu definisani. Dodatnim
parametrima mozemo odrediti ulazni konfiguracioni iskaz za povezivanje pull-up ili pull-
down otpornika, pomocu softvera na ulaznom pinu. Ovo su neophodni iskazi:

Za pull-up otpornike:

GPIO.setup(channel, GPIO.IN, pull_up_down=GPIO.PUD_DOWN)
Za pull-down otpornike:

GPIO.setup(channel, GPIO.IN, pull_up_down=GPIO.PUD_UP)

Na ulaznom pinu mozemo otkriti promenu ivice ulaznog signala. Promena ivice je kada se
signal menja iz LOW u HIGH (rastuca ivica) ili iz HIGH u LOW (opadajuca ivica). Na
primer, pritisak na taster moze izazvati promenu ivice na ulazu pina. Iskazi koji su dati u
nastavku mogu se koristiti za ¢ekanje ivice ulaznog signala. Ovo su funkcije blokiranja, tj.
program ce sacekati dok se na ulaznom signalu ne detektuje odredena ivica. Na primer,
ako je ovo taster, program Ce sacekati dok se ne pritisne taster:

Za cekanje rastuce ivice:
GPIO.wait_for_edge(channel, GPIO.RISING)
Za cekanje opadajuce ivice:
GPIO.wait_for_edge(channel, GPIO.FALLING)

Takode mozemo da satekamo dok se ne detektuje rastuca ili opadajuca ivica, koriste¢i
sledeci iskaz:

GPIO.wait_for_edge(channel, GPI0.BOTH)

Mozemo koristiti funkciju detekcije dogadaja sa ulaznim pinom. Na ovaj na¢in mozemo
izvrsiti kod za detektovanje dogadaja kad god je detektovan. Dogadaji mogu biti rastuca
ivica, opadajuca ivica ili promena na bilo kojoj ivici signala. Detekcija dogadaja se obi¢no
koristi u petljama u kojima mozemo da proveravamo dogadaj dok izvr$avamo drugi kod.

Na primer, da biste dodali detekciju rastu¢ih dogadaja u ulazni pin koristite slede¢i iskaz:

GPIO.add_event_detect (kanal, GPIO.RISING)
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Mozemo proveriti da li se dogadaj desio pomocu sledeceg iskaza:

If GPIO.event_detected(channel):

Detekcija dogadaja se moze ukloniti pomocu sledeceg iskaza:
GPIO.remove_event_detect(channel)

Takode mozemo koristiti objekte prekida (ili povratne pozive) da bismo detektovali do-
gadaj. Ovde se dogadajem upravlja unutar korisnicke funkcije. Glavni program izvr§ava
svoje uobicajene zadatke i ¢im se dogadaj desi, program prestaje sve $to radi i prelazi na up-
ravljanje dogadajem funkcija. Na primer, iskaz koji je dat u nastavku se moze koristiti za
dodavanje upravljanja dogadajem zasnovanim na prekidu u nase programe na rastucoj
ivici ulaznog signala. U ovom primeru kod za upravljanje dogadajem je funkcija koja je
nazvana MyHandler:

GPIO.add_event_detect(channel, GPIO.RISING, callback=MyHandler)

Mozemo dodati vise prekida, koriste¢i funkciju add_event_callback. Ovde se funkcije
povratnog poziva izvr§avaju uzastopno:

GPIO.add_event_detect(channel, GPIO.RISING)
GPIO.add_event_callback(channel, MyHandlerl)
GPIO.add_event_callback(channel, MyHandler2)

Kada u projektima koristimo mehanicke prekidace, dobijamo ono $to je poznato kao prob-
lem odskakanja prekidaca. To se dogada kada kontakti prekidaca odsko¢e mnogo puta dok
se ne ,smire“. Odskakanje prekidaca moze da generi$e nekoliko impulsa pre nego $to se
prekida¢ ,,smiri“. Mozemo da izbegnemo probleme u vezi sa odskakanjem prekidaca u
hardveru ili softveru.
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GPIO biblioteka obezbeduje parametar pod nazivom bouncetime koji se moze koristiti za
uklanjanje problema odskakanja prekidaca. Primer upotrebe ovog parametra prikazan je
ispod, gde se pretpostavlja da je vreme odskakanja prekidaca 10 ms:

GPIO.add_event_detect(channel, GPIO=RISING,callback=MyHandler, bounce-
time=10)
Takode mozemo da upotrebimo iskaz bouncetime da bismo odredili vieme odskakanja za
prekidac na slede¢i nacin:
GPIO.add_event_callback(channel, MyHandler, bouncetime=10)
Da bismo procitali stanje ulaznog pina, mozemo upotrebiti slede¢i iskaz:

GPIO.input(channel)

Konfiguracija izlaza
Sledeci iskaz se koristi za konfigurisanje kanala kao izlaza. Ovde se kanal odnosi na broj
porta zasnovanim na ranije navedenom iskazu setmode:

GPIO.setup(channel, GPIO.OUT)

Mozemo odrediti vrednost za izlazni pin tokom njegovog podesavanja. Na primer, mozemo
da konfiguriemo kanal kao izlaz i da istovremeno podesimo njegovu vrednost na HIGH
(+3,3V):

GPIO.setup(channel, GPIO.OUT, initial=GPIO.HIGH)
Za slanje podataka na pin izlaznog porta mozemo koristiti slede¢i iskaz:
GPIO.output(channel, value)

Gde vrednost moze biti 0 (ili GPIO.LOW, odnosno False), ili 1 (ili GPIO.HIGH, odnosno
True).

Na kraju programa trebalo bi da vratimo sve iskori$¢ene resurse u operativni sistem. To se
postize dodavanjem sledeceg iskaza na kraju naseg programa:

GPIO.cleanup()

2.9 Ciklus razvoja projekta Raspberry Pi

Ciklus razvoja projekata generalno uklju¢uje razvoj hardvera i softvera. U jednostavnim pro-
jektima u kojima se ne koristi spoljni hardver, mozemo jednostavno koristiti Raspberry Pi
plo¢u onakvu kakva jeste i tada je potreban samo razvoj softvera. Medutim, ve¢ina projekata
su slozeniji i zahtevaju dodatne spoljne komponente, kao $to su LED, motori, displeji, tas-
tature itd. Tada programer mora da osigura da hardver bude pravilno podesen i da je u
potpunosti funkcionalan pre nego $to se kreira bilo koji softver. Ako hardver nije pravilno
podesen, izgubi¢emo vreme pokusavajuci da razvijemo softver. Razvoj hardvera moze za-
htevati dodatne vestine, kao $to su poznavanje povezivanja i pravilno kori$¢enje razli¢itih
elektronskih komponenata na sistemima koji se zasnivaju na mikrokontrolerima.
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Ciklus razvoja projekta, posebno ciklus razvoja softvera, je iterativni proces u kojem pro-
gramer mora da se vrati i da nastavi da unosi izmene u kod dok ne dobije trazeni odgovor
od sistema u razvoju. Postoje razne alatke koje mogu biti korisne tokom razvoja projekta.
Na primer, dijagrami toka, jezik za opisivanje programa (PDL - Program Description Pro-
gram), UML, masine stanja i mnoge druge alatke koje se mogu koristiti tokom razvojnog
ciklusa.

U projektima za Raspberry Pi u ovoj knjizi koristicemo programski jezik Python. Ovaj
jezik je veoma mocan interaktivni programski jezik koji se uci kao prvi programski jezik
na mnogim univerzitetima i fakultetima $irom sveta. Python je dostupan na racunarima
Raspberry Pi i podrzava veliki broj biblioteka koje znatno pojednostavljuju zadatak pro-
gramiranja.

U ostatku ovog poglavlja kreiracemo jednostavan projekat, koriste¢i dvobojnu LED plocu
KY-011, kao i u prethodnom poglavlju.

2.10 Projekat — Treperenje dvobojnog LED-a

Opis - Ovo je mozda najjednostavniji projekat koji mozete dizajnirati, koriste¢i Raspberry
Pi. U ovom projektu dvobojni LED sa zajednickom katodom povezan je sa Raspberry Pi-
em. LED boje trepere naizmenic¢no brzinom od jedne sekunde.

Cilj - Cilj ovog projekta je da se prikaze kako se program moze napisati i pokrenuti na
Raspberry Pi-u. Projekat takode prikazuje kako se koriste neki od I/O i funkcija za podesa-
vanje vremena na Raspberry Pi-u.

Senzor koji se koristi - U ovom projektu se koristi senzor KY-011, kao i u prethodnom
poglavlju. Senzor i njegovi pinovi prikazani su na slici 1.3. Senzor ima 3 pina - crveni LED
pin, zeleni LED pin i GND pin. Zeleni LED pin oznacen je slovom S na ploci, radi iden-
tifikacije. LED se ukljucuje kada se logi¢ka 1 primeni na njegove pinove.

Blok dijagram - Blok dijagram projekta prikazan je na slici 2.21.

Raspberry
Pi
RED LED
GREEN LED

Slika 2.21 Blok dijagram projekta
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Elektri¢na $ema - Elektri¢na $ema projekta prikazana je na slici 2.22. Zeleni i crveni LED
pinovi su povezani sa pinovima porta GPIO 2 (pin 3) i GPIO 3 (pin 5) Raspberry Pi-a
putem otpornika za ograni¢avanje struje. GND pin je povezan sa Raspberry Pi GND pinom.
Vrednost otpornika za ogranicavanje struje izracunava se na sledeci nacin:

Visoki napon GPIO pina je 3,3 V. Napon na LED-u je oko 2,0 V (za crveni LED je 1,8 V, a
za zeleni LED 2,8 V). Propusna struja u LED-u zavisi od tipa LED-a koji se koristi i koli¢ine
potrebne svetline. Pod pretpostavkom da smo izabrali propusnu struju od 5 mA, tada je
vrednost otpornika za ogranicavanje struje (svetlina LED-a se moze povecavati, tako sto ce
se povecavati propusna struja):

R=(3,3V-2V)/5mA =260 oma. Izabrali smo otpornike od 220 oma da bismo
omogucili 6 mA propusne struje za svaki LED (za zeleni LED mozete koristiti
manju vrednost, npr. 150 oma)

Raspberry Pi

KY-011

cPIo2P—24% 16
GPI03 P—22% 1R

ol

Slika 2.22 Elektricna Sema projekta

Konstrukcija - Projekat je izraden na prototipskoj plo¢i, kao $to je prikazano na slici 2.23.
Kratkospojnici se koriste za povezivanje senzora KY-011 sa digitalnim pinovima porta 2
i 31 GND-om Raspberry Pi-a.

Slika 2.23 Projekat koji je konstruisan na prototipskoj ploci
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Listing programa - Program se zove rpitwoled.py, a listing je prikazan na slici 2.24. Na
pocetku programa uvezene su biblioteke RPI.GPIO i time. GPIO brojevi porta 2 i 3 se do-
deljuju zelenom LED pinu i crvenom LED pinu, tim redom. LED-ovi se zatim konfigurisu
kao izlazi. Ostatak programa se izvrsava u beskonacnoj petlji. Unutar ove petlje zeleni i cr-
veni LED-ovi trepere naizmeni¢no, sa kasnjenjem od jedne sekunde izmedu svakog izlaza.

Program mozete pokrenuti iz komandne linije unosom slede¢e komande (znakovi koje je
uneo korisnik podebljani su radi jasnoce):

pi@raspberrypi:~ $ python rpitwoled.py

B
# TWO COLOUR LED FLASHING

# ======z=================

#

# In thiS project the two colour LED KY-011 is used. The

# green and red LED pins are conncted to Raspberry Pi port
# pins GPIO2 and GPIO3. The LEDs flash alternately with a
# rate of one second

#

# Author: Dogan Ibrahim

# Date : April 2019

# File : rpitwoled.py

B
import RPi.GPIO as GPIO # dmport Rpi library

import time # dmport time library
GPIO.setwarnings(False) # disable warnings
GPIO.setmode (GPIO.BCM) # set BCM mode

GreenlLED = 2 # green LED

RedLED = 3 # red LED

ON = 1

OFF = 0

GPIO.setup(GreenLED, GPIO.OUT) # Configure as output
GPIO.setup(RedLED, GPIO.OUT) # configure as output

do forever
green LED ON
red LED OFF
wait 1 second
green LED ON
red LED ON
wait 1 secons

while True:
GPIO.output(GreenLED, ON)
GPIO.output(RedLED, OFF)
time.sleep (1)
GPIO.output(GreenLED, OFF)
GPIO.output(RedLED, ON)
time.sleep (1)

H o H H FH H H

Slika 2.24 Listing programa projekta
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Napomena: Mozda ¢e vam biti lakse da kreirate i da pokrenete Python programe iz GUI
desktop interfejsa (IDLE 2), jer se odgovarajuca uvlacenja automatski stavljaju u vas kod
dok kucate.

Sta smo naudili - U ovom projektu smo naudili kako da koristimo slede¢e Raspberry Pi
funkcije:

import: uvozi bibliotecki modul u program
GPIO.setmode(mode): podesava rezim upotrebe GPIO pina u programu
GPIO.setvarnings(mode): onemogucava (False) ili omogucava (True)

poruke upozorenja
GPIO.setup(port pin, mode): postavlja pinski rezim rada kao ulaz ili izlaz
GPIO.output(port pin, value): salje vrednost (0 ili 1) na navedeni pin porta
time.sleep(n): kreira kasnjenje od n milisekundi
2.11 Rezime
U ovom poglavlju smo pregledali konfiguraciju pinova GPIO konektora i kako se
omogucava Wi-Fi modul i pristupa Raspberry Pi-u daljinski putem sa stonog ili prenosnog

racunara. Osim toga, pregledali smo dizajn jednostavnog projekta koji se zasniva na KY-
011 dvobojnom LED-u u kome se koristi programski jezik Python.

U slede¢em poglavlju cete videti kako se instalira firmver na ESP32 mikrokontroleru i kako
se koristi u projektima.
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